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END USER LICENSE AGREEMENT
[PANALOGVIEWER SOFTWARE VERSION 1.2.6]

YOU MUST READ AND ACCEPT ALL TERMS AND CONDITIONS OF 
THIS AGREEMENT BEFORE USING THIS SOFTWARE. 

PANAMETRICS, INC. ("LICENSOR") AGREES TO LICENSE THE 
SOFTWARE TO YOUR COMPANY ("LICENSEE") ONLY UNDER THE 
TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THESE 
TERMS, PROMPTLY RETURN THE CD, DOCUMENTATION AND ALL 

OTHER COMPONENTS OF THE SOFTWARE TO THE LICENSOR AND/
OR PERMANENTLY DELETE ALL ELECTRONIC FILES RELATED 

THERETO TO RECEIVE A REFUND OF LICENSE FEES PAID.

1. DEFINITIONS.

1.1 "Documentation" shall mean any 
Licensor user manuals and other printed 
materials delivered to Licensee in 
conjunction with the Programs.

1.2 "Intellectual Property Rights" shall 
mean patent rights (including patent 
applications and disclosures), copyrights, 
moral rights, trademark/service mark 
rights, trade dress rights, trade secrets, 
know-how and any other intellectual 
property rights recognized in any country 
or jurisdiction in the world.

1.3 "Programs" shall mean the 
PanaView computer software program 
referenced above, including all 
modifications, enhancements, and 
revisions thereto that are either: (i) 
expressly authorized by Licensor in 
writing; or (ii) created by Licensor 
pursuant to a software support agreement 
between the parties, if any.

2. LICENSE.

2.1 License Grant. Subject to the terms 
of this Agreement, Licensor grants 
Licensee a perpetual, non-transferable, 
non-exclusive license to install the 
Program on one personal computer and 
use the Programs and Documentation to 
support any number or combination of 
GE Panametrics instruments networked 
on the one personal computer. Licensee 
may make one additional copy of the 
Programs and Documentation solely for 
archival purposes.

2.2 License Restrictions. All Programs 
are licensed and not sold. Except as 
otherwise expressly provided in this 
Agreement, Licensee shall not make any 
copies of the Products or Documentation, 
and shall not decompile, disassemble, 
decrypt, extract or otherwise reverse 
engineer the Products. Any 
modifications, revisions, changes or 
enhancements made by Licensee to the 
Products or Documentation without 
Licensor's express prior written 
permission shall be deemed a material 

breach of this Agreement, and any 
Intellectual Property Rights created 
without permission shall become 
Licensor's sole property without any 
additional Licensor action necessary to 
perfect its ownership rights and interests. 
Notwithstanding anything to the contrary 
in this Agreement, all rights, title and 
ownership of any such modifications, 
revisions, changes and enhancements 
shall reside solely in Licensor. Except as 
expressly provided in Section 11.1, 
Assignment, the Programs shall not be 
sold, leased, assigned, transferred, 
distributed or sublicensed, in whole or in 
part. Licensee shall not delete or in any 
manner alter copyright, trademark or 
other proprietary rights notices of 
Licensor or its suppliers appearing on the 
Programs and Documentation.

3. TAXES. Licensee shall, in addition 
to any license payments required 
hereunder, pay all applicable sales, use, 
transfer, value-added or other taxes and 
all duties, whether international, national, 
state or local, however designated, which 
are levied or imposed by reason of the 
transaction(s) contemplated hereby, 
excluding only income taxes on net 
profits which may be levied against 
Licensor. Licensee shall reimburse 
Licensor for the amount of any such taxes 
or duties paid or accrued directly by 
Licensor as a result of said transaction(s). 
If Licensee is prohibited by law from 
making payments hereunder free of such 
deductions or withholdings, Licensee 
shall immediately notify Licensor and 
pay Licensor any additional sum(s) equal 
to such deduction or withholding.

4. WARRANTIES.

4.1 Limited Program Warranty. 
Licensor warrants that the media on 
which the Products are distributed shall 
be free from defects for a period of ninety 
(90) days after delivery. As Licensee's 
sole and exclusive remedy and Licensor's 
entire liability for any breach of this 
warranty, Licensor shall, at its sole 
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option: (i) repair or replace, at no 
additional charge to Licensee, any 
defective media; or (ii) if, despite using 
its reasonable efforts, Licensor is unable 
to replace the media, refund to Licensee 
the applicable license fees paid for the 
non-conforming media after Licensee 
returns the media to Licensor, less a 
reasonable license fee for the period 
during which Licensee had use of the 
Program, using straight-line depreciation 
assuming a useful life of the Program of 
three (3) years. The limited warranty set 
forth herein shall automatically become 
null and void if a party other than 
Licensor modifies the Programs in any 
way.

4.2 Disclaimer Of Warranties. 
EXCEPT FOR THE EXPRESS MEDIA 
WARRANTY ABOVE, THE 
PROGRAMS AND DOCUMENTATION 
ARE PROVIDED "AS-IS", WITH ALL 
FAULTS. LICENSOR MAKES NO 
OTHER WARRANTIES OF ANY 
KIND, EITHER EXPRESS OR 
IMPLIED. LICENSOR EXPRESSLY 
DISCLAIMS ANY AND ALL OTHER 
WARRANTIES, INCLUDING BUT 
NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF NON-
INFRINGEMENT AND THE IMPLIED 
WARRANTIES OF 
MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. 
LICENSOR DOES NOT WARRANT 
THAT THE PROGRAMS SHALL BE 
ERROR-FREE OR THAT THEY 
SHALL FUNCTION WITHOUT 
INTERRUPTION.

4.3 Excluded Uses. UNLESS 
EXPRESSLY PROVIDED IN A 
SEPARATE WRITTEN AGREEMENT, 
THE SOFTWARE MAY NOT BE USED 
AS ON-LINE CONTROL EQUIPMENT 
IN HAZARDOUS ENVIRONMENTS 
REQUIRING FAIL-SAFE 
PERFORMANCE, SUCH AS IN THE 
OPERATION OF NUCLEAR 
FACILITIES, AIRCRAFT 
NAVIGATION OR COMMUNICATION 
SYSTEMS, AIR TRAFFIC CONTROL, 
DIRECT LIFE SUPPORT MACHINES, 
OR WEAPONS SYSTEMS, IN WHICH 
THE FAILURE OF THE SOFTWARE 
COULD LEAD DIRECTLY TO DEATH, 
PERSONAL INJURY, OR SEVERE 
PHYSICAL OR ENVIRONMENTAL 
DAMAGE.

5. LIMITATIONS OF LIABILITY.

5.1 Exclusion of Damages. 
WHETHER ANY REMEDY SET 
FORTH HEREIN FAILS OF ITS 

ESSENTIAL PURPOSE OR 
OTHERWISE, IN NO EVENT SHALL 
LICENSOR BE LIABLE FOR ANY 
SPECIAL, INCIDENTAL, INDIRECT 
OR CONSEQUENTIAL LOSS, 
LIABILITY OR DAMAGES OF ANY 
KIND (INCLUDING BUT NOT 
LIMITED TO LOSS OF USE, DATA, 
BUSINESS OR PROFITS) WHETHER 
ARISING UNDER A THEORY OF 
CONTRACT, TORT (INCLUDING 
NEGLIGENCE), BREACH OF 
WARRANTY, PRODUCT LIABILITY 
OR OTHERWISE, AND REGARDLESS 
OF WHETHER LICENSOR HAS BEEN 
ADVISED OF THE POSSIBILITY OF 
SUCH LOSS, LIABILITY OR 
DAMAGES.

5.2 Total Liability. IN NO EVENT 
SHALL LICENSOR'S CUMULATIVE 
LIABILITY ARISING FROM OR 
RELATED TO THIS AGREEMENT, 
FROM ALL CAUSES OF ACTION OF 
ANY KIND, WHETHER ARISING 
UNDER A THEORY OF CONTRACT, 
TORT (INCLUDING NEGLIGENCE), 
BREACH OF WARRANTY, PRODUCT 
LIABILITY OR OTHERWISE, 
EXCEED THE TOTAL AMOUNT OF 
LICENSE FEES ACTUALLY 
RECEIVED BY LICENSOR FROM 
LICENSEE UNDER THIS 
AGREEMENT. SOME STATES OR 
JURISDICTIONS DO NOT ALLOW 
EXCLUSION OF IMPLIED 
WARRANTIES OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE 
LIMITATIONS MAY NOT APPLY TO 
YOU.

5.3 Basis of the Bargain. All warranty 
disclaimers and liability limitations set in 
this Agreement shall apply upon delivery 
of the Programs to Licensee. Licensee 
acknowledges that Licensor has set its 
prices and entered into this Agreement in 
reliance upon such disclaimers of 
warranty and the limitations of liability 
and that the same forms an essential basis 
of the bargain between the parties.

6. INDEMNIFICATION. LICENSEE 
SHALL INDEMNIFY, DEFEND AND 
HOLD LICENSOR HARMLESS FROM 
AND AGAINST ALL CLAIMS, 
LIABILITIES, ACTIONS, SUITS, 
DEMANDS, FINES, PENALTIES AND 
ALL COSTS AND EXPENSES 
INCURRED BY LICENSOR IN 
CONNECTION THEREWITH 
(INCLUDING REASONABLE 
ATTORNEYS' FEES) ARISING OUT 
OF OR RELATED TO: (A) LICENSEE'S 
iv End User License Agreement
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USE OF THE PROGRAMS IN 
COMBINATION WITH SOFTWARE 
OR HARDWARE NOT SPECIFICALLY 
APPROVED BY LICENSOR IN 
WRITING; (B) LICENSOR'S 
COMPLIANCE WITH DESIGNS OR 
SPECIFICATIONS PROVIDED BY 
LICENSEE; (C) ANY MODIFICATION, 
ENHANCEMENT OR REVISION 
MADE TO THE PROGRAMS BY 
ANYONE OTHER THAN LICENSOR; 
OR (D) LICENSEE'S FAILURE TO USE 
ANY MODIFICATION, 
ENHANCEMENT OR REVISION 
PROVIDED TO LICENSEE BY 
LICENSOR FOR THE PURPOSE OF 
AVOIDING A CLAIM OF 
INFRINGEMENT.

7. TERMINATION.

7.1 Termination for Breach. Either 
party may terminate this Agreement with 
respect to one or all of the Programs in 
the event of a breach or default by the 
other party; provided, however, no such 
termination shall occur until the non-
breaching/defaulting party shall have 
given written notice of the breach or 
default to the breaching/defaulting party 
and such breach or default shall not have 
been cured within five (5) days in the 
event of a monetary breach or default and 
thirty (30) days in the event of a non-
monetary breach or default.

7.2 Automatic Termination. This 
Agreement shall terminate automatically 
if: (i) either party becomes the subject of 
any voluntary or involuntary petition in 
bankruptcy or any proceeding relating to 
insolvency, receivership, liquidation or 
composition for the benefit of creditors, 
and in the case of an involuntary petition 
or proceeding such petition or proceeding 
is not dismissed within sixty (60) days of 
filing; or (ii) Licensee fails to pay license 
fees when due or commits a material 
breach of the license provisions in 
paragraph 2 above.

7.3 Effect of Termination. Upon any 
termination of this Agreement or of any 
individual Program license, Licensee 
shall promptly return to Licensor or, at 
Licensor's election, destroy the applicable 
Programs and Documentation and all 
copies and portions thereof, in all forms 
and types of media related thereto, and 
provide Licensor with an written 
certification signed by a duly authorized 
representative of Licensee, certifying to 
Licensee's compliance with the 
foregoing. Licensee's exclusive remedy 
for breach shall be the return of all license 

fees received by Licensor related to the 
affected Programs.

7.4 Non-exclusive Remedy. Except as 
provided otherwise in this Agreement, all 
remedies of either party shall be non-
exclusive and shall be without prejudice 
to any other right or remedy of such party.

8. SURVIVAL. All provisions of this 
Agreement relating to liability, 
warranties, indemnities or confidentiality, 
and the provisions of Sections 7, 10 and 
11 of this Agreement, shall survive the 
expiration or termination of this 
Agreement.

9. GOVERNING LAW. This 
Agreement will be governed by and 
construed in accordance with the 
substantive laws in force: a) in the State 
of New York excluding its conflict of 
laws rules if this license is purchased 
when you are in the United States, 
Canada or Mexico; or b) in Japan if this 
license is purchased when you are in 
Japan, China, Korea, R.O.C. or another 
Southeast Asian country where all official 
languages are written in either an 
ideographic script (e.g. hanzi, kanji or 
hanja), an/or other script based upon or 
similar in structure to an ideographic 
script; or c) the Netherlands if this license 
is purchased when you are in any other 
jurisdiction not described above. The 
respective courts of New York, Tokyo 
and Amsterdam as applicable hereunder 
shall each have non-exclusive jurisdiction 
over all disputes relating to this 
Agreement. This Agreement will not be 
governed by the conflict of laws rules of 
any jurisdiction or the United Nations 
Convention on Contracts for the 
international Sale of Goods, the 
application of which is expressly 
excluded.

10. INJUNCTIVE RELIEF. If Licensee 
breaches, or threatens breach of any part 
of this Agreement, Licensee 
acknowledges and agrees that Licensor 
will be greatly damaged, and such 
breach(es) will be irreparable and 
damages associated therewith will be 
difficult to quantify; therefore, Licensor 
may apply to any court of competent 
jurisdiction, who, notwithstanding the 
Governing Law provisions above, will 
apply the laws of its own jurisdiction in 
determining whether relief shall be 
granted to Licensor, for injunctive or 
other equitable relief to restrain such 
breach or threat of breach, without 
impairing, invalidating, negating or 
voiding Licensor's other rights to relief 
either at law or in equity.
End User License Agreement v
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11. General

11.1 Assignment. Licensee may assign 
this entire Agreement with the sale of any 
of its GE Panametrics instruments 
provided that Licensee and its assignee 
agrees in writing to comply with all 
provisions of this Agreement. Otherwise, 
Licensee may not assign this Agreement 
without Licensor's prior written consent. 
Any other attempted assignment shall be 
null and void and shall automatically 
terminate this Agreement.

11.2 Compliance with Laws and Export. 
Each party shall comply in all material 
respects with all laws, rules, approvals, 
registrations and regulations of the 
United States and other countries that 
may be applicable to the Programs or to 
each party's activities under this 
Agreement. In addition, you agree that 
the Products and Documentation will not 
directly or indirectly be shipped, 
transferred or exported or re-exported 
into any country or used in any manner 
prohibited by the United States Export 
Administration Act or any other export 
laws, restrictions or regulations 
(collectively "Export Laws"). If the 
Programs are identified as export-
controlled items under the Export Laws., 
you represent and warrant that you are 
not a citizen of or otherwise located 
within a U.S.-embargoed nation and that 
you are not otherwise prohibited under 
the Export Laws from receiving the 
Programs or Documentation. All right to 
use the Programs and Documentation are 
granted on condition that such rights are 
forfeited if you fail to comply with the 
terms of this Agreement.

11.3 Severability. If any or all of the 
covenants hereunder are determined by a 
court of competent jurisdiction to be 
invalid or unenforceable, by reason that 
the breadth of restrictions are too great, or 
for any other reason, these covenants 
shall be modified and interpreted to 
extend over the maximum geographic 
area, period of time, range of activities or 
other restrictions to which they may be 
enforceable.

11.4 Force Majeure. Licensor shall not 
be responsible for any failure or delay in 
its performance under this Agreement 
due to causes beyond its reasonable 
control, including but not limited to, labor 
disputes, strikes, lockouts, shortages of or 
inability to obtain labor, energy, raw 
materials or supplies, war, riot, act of God 
or governmental action.

11.5 Entire Agreement. This Agreement 
is the complete and exclusive agreement 
between the parties with respect to the 
subject matter hereof, superseding and 
replacing any and all prior or 
contemporaneous agreements, 
communications, and understandings 
(both written and oral) regarding such 
subject matter. Any waiver, modification 
or amendment of any provision of this 
Agreement shall be effective only if in 
writing and signed by duly authorized 
representatives of the parties hereto.

11.6 Attorneys Fees. In the event that 
either party resorts to legal action to 
enforce its rights under this Agreement, 
the prevailing party in such action shall 
be entitled to have all costs and expenses 
incurred in such action, including courts 
costs and reasonable attorneys fees, paid 
by the other party.

11.7 Notice to U.S. Government End 
Users: The Programs and Documentation 
are "Commercial Items" as that term is 
defined at 48 C.F.R. § 2.101, consisting 
of "Commercial Computer Software" and 
"Commercial Computer Software 
Documentation", as such terms are used 
in 48 C.F.R. § 12.212 or 48 C.F.R. § 
227.7202, as applicable. Consistent with 
48C.F.R. § 12.212 or 48 C.F.R. § 
227.7202-1 through 227.7202-4, as 
applicable, the Commercial Computer 
Software and Commercial Computer 
Software Documentation are licensed to 
U.S. Government end users: a) only as 
Commercial Items; and b) with only 
those rights granted to all other end users 
pursuant to the terms and conditions 
herein. For U.S. Government end users, 
Panametrics agrees to comply with all 
applicable equal opportunity laws 
including, if appropriate, the provisions 
of Executive Order 11246 as amended, 
Section 402 of the Vietnam Era Veterans 
Readjustment Assistance Act of 1974 and 
Section 503 of the Rehabilitation Act of 
1973, as amended, and the regulations at 
41 C.F.R. Parts 60-1 through 60-60,
60-250 and 60-741. The affirmative 
action clause and regulations contained in 
the preceding sentence shall be 
incorporated by reference in this 
Agreement.
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Introduction

GE Panametrics’ TransPort® PT878 portable flowmeter and 
PM880 portable hygrometer feature many advanced capabilities. 
Among the most useful of these is the built-in data logger, which 
permits the user to record measurements as a function of time and 
to store the resulting data points in a log file.

The data log files (*.log) created by the PT878/PM880 can be 
viewed in either text or graphic format on the built-in LCD 
display or they can be viewed on a remote computer screen with 
GE Panametrics’ PanaView™ instrument interface software. 
However, to add even more versatility and convenience to the 
data logging process, GE Panametrics has developed a Visual 
Basic (VB) software utility called PanaLogViewer™ that allows 
users to open the PT878/PM880 data log files for viewing and to 
export these files in Microsoft Excel format (*.xls). The 
converted files can then be manipulated and graphed in Microsoft 
Excel just like any other spreadsheet file.

As a service to our customers, GE Panametrics has chosen to 
make this software available free of charge to all PT878/PM880 
owners. This guide provides instructions for installing and 
operating the PanaLogViewer program.

Preparing to Use PanaLogViewer

In order to use the PanaLogViewer utility, the following steps 
must first be completed:

Note: PanaLogViewer is intended for use on a computer 
running the Microsoft Windows operating system.

1. Establish communications between the PT878/PM880 and a 
remote computer via the built-in infrared interface. Refer to 
your User’s Manual for instructions.

2. Make sure you have your PanaLogViewer CD ready.

3. Install PanaLogViewer on your computer
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2 PanaLogViewer

Installing PanaLogViewer

To install the software, proceed as follows:

1. Locate the Setup.exe file in the Program folder on your 
installation CD. Double-click on this file.

2. The InstallShield Wizard will load. At the Welcome Screen 
shown below, click the [Next>] button to begin the installation.
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Installing PanaLogViewer (cont.)

3. At the License Agreement screen shown below, read the End 
User License Agreement and select the button that indicates 
that you accept the agreement. Then, click the [Next>] button 
to continue.

Note: The text of the End User License Agreement is 
reproduced at the beginning of this manual. If you choose 
not to accept the agreement, the installation will not 
continue.
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Installing PanaLogViewer (cont.)

4. At the Customer Information screen shown below, enter your 
user name and company name. Also, indicate whether the 
program should be available to all users of the computer or 
only to your login name. Then, click the [Next>] button to 
continue.
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Installing PanaLogViewer (cont.)

5. At the Destination Folder screen shown below, default folder 
for the program files (recommended) is indicated. Click the 
[Next>] button to continue.

Note: To install the program files in a different folder, click on 
the [Change] button and browse to the desired folder.
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Installing PanaLogViewer (cont.)

6. At the Ready to Install the Program screen shown below, 
review the setup information that you entered at the previous 
screens. If everything is acceptable, click the [Install] button to 
begin copying the program files to your hard drive.

Note: If you wish to revise any of the information, click on the 
[<Back] button and make the necessary changes.
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Installing PanaLogViewer (cont.)

7. At the InstallShield Wizard Completed screen shown below, 
click the [Finish] button to finalize the installation.

Note: The final step of the installation program will place a 
PanaLogViewer icon on your desktop and a new program 
group on your Start menu.
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Starting PanaLogViewer

After PanaLogViewer has been successfully installed, the 
program may be launched either from the Start Menu or from the 
Shortcut placed on your desktop during installation. The selection 
is made just like any other Windows application. That is, click on 
the [Start] button and scroll through your Program Menu to the 
[GE Panametrics] Program Group and click on the 
[PanaLogViewer] entry. Alternatively, just double-click the 
desktop shortcut (see the figure below).
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The User Interface

When the program is first launched, the following screen appears:

As shown above, the PanaLogViewer user interface includes the 
following components:

• Title Bar: shows the application name and includes the usual 
Windows control buttons at the far right.

• Menu Bar: includes the File, Options and Help menus.

• File Menu: includes the Open and Exit options.

• Options Menu: includes the Delimiter option.

• Help Menu: includes the About option.

• Log Data Area: includes the Log Info and Export Options.

• Log Info: these boxes are automatically populated when 
you open a log file.

• Export Options: The boxes allow you to specify the type 
of file to export and the log parameters to include.

• Status Area: the white box across the bottom of the window 
that lists a description of the events that have occurred since 
the program was launched.
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The About Menu Option

When you select the Help menu on the menu bar, the About 
option appears in the drop-down list box:

Select the About option to view the version information for your 
software.

When you have finished reading the information, click the [OK] 
button to close the window.
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The Delimiter Menu Option

When you select the Options menu on the menu bar, the 
Delimiter option appears in the drop-down list box:

Select the Delimiter option to specify the type of text file that you 
wish to export (see the figure below). Simply type the desired 
delimiter character in the box and click on the [OK] button.

Note: The default delimiter is the comma, as a comma-delimited 
text file is easily imported into most spreadsheet 
programs. However, other delimiters (such as the Tab) 
may be used as desired.
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The Open Menu Option

When you select the File menu on the menu bar, the following 
options appear in the drop-down list box:

To open a PT878/PM880 log file for viewing and/or exporting, 
select the File menu on the menu bar, and click on the Open 
option in the drop-down list box. Then, navigate to the directory 
on your hard drive where your log files are stored, and open the 
desired log file (the Sample.log file and the Sample Files folder 
are used here as an example).



March 2003
PanaLogViewer 13

Viewing a Log File

After opening a log file as described on the previous page, the log 
data that was programmed into the PT878/PM880 at the time the 
log was created is automatically entered in the appropriate fields. 
The typical data for our sample log is shown below.

The following items are listed on the above display:

Note: See your PT878/PM880 User’s Manual for a discussion of 
the parameters listed above.

• Log Name: • Records:

• Start Time: • Log Flags:

• End Time: • Units:

• Interval:
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Exporting a Log File

After viewing a log file as described in the previous section, you 
may wish to export the log file into standard Microsoft Excel 
format so that it may be opened in that application in the future. 
To accomplish this, refer to the figure on the previous page and 
complete the following steps:

1. Select the Units columns to be exported. You may either 
check the individual units boxes or click on the [Select All 
Units] button to include them all.

Note: The Date/Time column is always exported.

2. You may choose to include or not include the Log Information 
in your exported file by either checking or unchecking this 
box at the right side of the viewing window.

3. You may choose to export the Errors column of the log file or 
not (recommended) by either selecting or deselecting the 
Include Errors option.

4. In the drop down list box, select the type of file to be exported:

• Delimited Text File - as specified in the Options>Delimiter 
menu.

• Excel (*.xls) - standard Microsoft Excel worksheet file

5. When you have completed all of your selections, press the 
[Export] button to proceed.

Note: The example on the next page shows the export of a 
Microsoft Excel file as an example. The general 
procedure is identical for exporting a delimited text file.
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Exporting a Log File (cont.)

After you have configured the export file on the previous page, 
you will be asked to name the exported file and specify a 
destination directory:

At the above window, complete the export process by performing 
the following steps:

1. Save in: - Browse to the desired destination directory so that 
its name appears in this box.

2. Save as type: - Make sure that Excel Files [*.xls] has been 
selected in this box.

3. File name: - Enter the desired name for the exported file in 
this box.

4. Click on the [Save] button.

IMPORTANT: If you choose a file name that is the same as an 
already existing file in the same folder, you must 
give permission to overwrite the old file.

After completing step 4, the specified file will be exported and 
you will be returned to the standard PanaLogViewer window.
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The Exit Menu Option

When you have finished using PanaLogViewer, select the File 
menu on the menu bar (see the figure at the top of page 12) and 
click on the Exit option. This will close the application and return 
you to the Windows desktop.

Note: You may also close the application by clicking on the [X] 
control button at the far right of the title bar.

Opening the File in Microsoft Excel

After exporting a PT878/PM880 log file as described on page 14, 
the file may be opened in Microsoft Excel. First, launch your 
version of Microsoft Excel and select Open from the File menu.

Note: Only a general overview of the procedure is provided 
here. If you are unfamiliar with the program, consult your 
Microsoft Excel documentation for more details.

Navigate to the directory where your exported log file is stored 
and select the desired file. Then, click on the [Open] button. This 
will launch Excel’s three-step text import wizard.
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Opening the File in Microsoft Excel (cont.)

At step 1, the exported file is identified as a Delimited text file. 
Accept this default and click on the [Next>] button.

At step 2, specify the type of delimiter and click on the [Next>] 
button.
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Opening the File in Microsoft Excel (cont.)

At step 3, you may set the data format for each column. Accept 
the default and click on the [Finish] button. You can always 
reformat the data after the file has been opened. The file will now 
be opened and displayed in the Microsoft Excel window.

You may now perform any operations on the file that you could 
on any other Microsoft Excel spreadsheet (see your Microsoft 
Excel documentation for instructions).
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Opening the File in Microsoft Excel (cont.)
You may have noticed in the window at the bottom of page 18 
that the default formatting for the first column (Time) shows the 
date in MM/DD/YY format followed by the time in HH:MM 
format. However, the time data that was exported from the 
PT878/PM880 log file also includes the seconds information. If 
you wish to show this data in the Excel file, reformat column A 
for time in the HH:MM:SS format.

Note: If you choose to display the seconds time data using the 
standard Excel format, the date information is no longer 
shown. If you wish to show both the date and the seconds, 
insert a copy of column A and format the two columns 
accordingly (see your Excel documentation for details).



Saving the File in Microsoft Excel

After opening the exported PT878/PM880 log file in Microsoft 
Excel and manipulating the spreadsheet as desired, you must save 
the file as an Excel spreadsheet to retain the information. To do 
this, open the File menu and click on the Save option:

To save your changes in Microsoft Excel format, click on the 
[Yes] button.

Make sure that Microsoft Excel Workbook (*.xls) is selected in 
the Save as type: box and click on the [Save] button.
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Saving the File in Microsoft Excel (cont.)

If you have chosen to save the file in the same directory used to 
store your exported log files, you will be warned that a file with 
the same name already exists. The is the original delimited text 
file that was exported from PanaLogViewer. You may proceed in 
one of two ways:

• If you have no further need for the original exported file, 
simply click the [Yes] button to overwrite it with the properly 
formatted Excel workbook file created in the previous section.

or

• If you wish to retain the original exported file, click the [No] 
button to return to the Save As window shown at the bottom of 
the previous page. Then, choose a different file name and click 
the [Save] button.

Your file is now a standard Microsoft Excel workbook file and 
can be opened in the future without performing the three-step text 
import wizard.
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